USC Psychology 316L (52619)

. Non-Experimental Research Methods
Dornsife Fall 2014

Dana and David Dornsife
College of Letters, Arts

‘}r)lc; f:j;zjftso/_])wmU Lecture Location: Kaprielian Hall, Room 163
T Days and Time: Tuesday & Thursday; 2:00 p.m. to 3:20 p.m.

ALL Labs Location: King Hall, Room 208

ALL Labs on Mondays: 12:00 p.m. to 1:50 p.m. and 2:00 p.m. to 3:50 p.m.

Online portion at http://blackboard.usc.edu

Instructor Information

Dr. Clayton L. Stephenson Office Location: SGM, Room 526
Lecturer Office Hours: Tuesday, Thursday, & Friday
clstephe@usc.edu 10:00 a.m. — 12:00 p.m.; and by appointment

(213) 740-9019

TA Information
Drew Petkus, Ph.D.
detkus@usc.edu

Syllabus
Course Description
Psychology is a science. Although the majority of psychological scientific inquiry uses
experimental research procedures, there are other methods of inquiry we can use to create
knowledge and even promote social change. This course will provide you with additional
methodological tools and skills to help you become a better critical thinker and psychological
scientist. The primary goal of the course is for you to learn new data collection techniques while
providing service in the community. You will learn about interpretive frameworks; qualitative
approaches; analyzing qualitative data derived from interviews, observations, and documents;
becoming literate in quantitative non-experimental methods; and write a qualitative research
paper adhering to the Publication Manual of the American Psychological Association.

Prerequisites
PSYC 100 (Introduction to Psychology)

PSYC 314 (Research Methods)

Teaching Obijectives
e Provide students with the fundamental knowledge of interpretive frameworks for qualitative
research.
o Facilitate students’ service learning experience while using qualitative research methods.
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e Guide and mentor students in understanding more complex non-experimental methods.

Student Learning Objectives
After successfully completing this course, students will be able to . . .
o identify areas in psychology in which they have strong interests.
o describe, discuss, and debate the interpretive frameworks in science.
o critically analyze articles using qualitative or mixed methods.
e analyze and interpret qualitative data.
e understand and discuss research articles that use quantitative non-experimental methods.
e write a qualitative research paper adhering to the APA Publication Manual requirements.

Required Texts
Creswell, J. W. (2013). Qualitative inquiry & research design: Choosing among five approaches (3"
ed.). Thousand Oaks, CA: Sage Publications.
Miles, M. B., Huberman, A. M, & Saldafia, J. (2014). Qualitative data analysis: A methods sourcebook
(3“ed.). Thousand Oaks, CA: Sage Publications.
NOTE: Creswell textbook is abbreviated as (CRES) in the schedule. Miles, Huberman, and Saldafia
textbook is abbreviated as (MHS).

Recommended Texts

American Psychological Association. (2010). Publication manual of the American psychological
association (6™ ed.). Washington, DC: American Psychological Association.

Schwartz, B. M., Landrum, R. E., & Gurung, R. A. R. (2014). An easy guide to APA style (2" ed.).
Thousand Oaks, CA: Sage Publications, Inc.

Supplemental Readings. (Various dates). Posted on Blackboard.
NOTE: Texts are available at the bookstore or online.

Assessment Due Date | Percent of Final Grade: Points

Blackboard CT Assignments Each Wednesday 10 (individual grade): 10-20

Volunteer Service December 5" at 11:59 p.m. 10 (individual grade): 100

Research Proposal October 30" at 11:59 p.m. 10 (individual grade): 100

Three Observations November 7", 21t and 10 (individual grade): 10, 25, 50
December 5" at 11:59 p.m.

One Transcribed Interview December 1% at 11:59 p.m. 10 (individual grade): 50

Final Research Paper December 11" at 11:59 p.m. 20 (individual grade): 100

Lab Assignments Continuous 10 (individual or group): 10-20

Participation/Exercises = Continuous 10 (individual or group): 5-20

Lecture (5%) + Lab (5%)

Blackboard Critical Thinking (CT) Assignments

Each week you will complete a critical thinking assignment that will be posted on Blackboard. The
assignments are designed to help you comprehend the material covered for that week. The assignments
will also prepare you for lecture-discussion sections on Thursdays. These assignments are due
Wednesdays at 11:59 p.m. No assignment is due the first week of class.
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Volunteer Service

Part of collecting qualitative data is becoming involved in a group, organization, or culture. One of the
easiest ways to accomplish this goal is to volunteer and become part of the group. You will volunteer for
an organization or program for two to three hours out of the week for a minimum of eight weeks. You will
be evaluated based on actually completing the hours and an evaluation provided by your supervisor.
Because you are part of USC, | expect you to be professional, respectful, and maintain the highest
standards of a scholar/researcher while volunteering and collecting data. Many of you will acquire
volunteer position using USC’s Joint Educational Project at https://dornsife.usc.edu/joint-educational-
project/. However, if you are currently volunteering somewhere, you may use that service to fulfill this
requirement. Your current volunteer service must be approved by me, so please come discuss it with me
as soon as possible.

Research Proposal & Final Research Paper

You will write a research proposal throughout the first half of the semester and collect data once you start
your volunteer position. The research proposal is an important process in providing a clear statement of
the problem, an argument for the purpose of your study using appropriate sources, how previous research
relates to your study, a formal statement of problem or research questions, a full methods section, and a
detailed data analysis plan. The final research paper will be the result of your semester’s lab work and a
demonstration of your ability to apply your knowledge so that you have a real qualitative study to report.
If possible, you should work in groups of two or three to complete the project, but you will write the
proposal and final paper individually. Please Note: These two papers are 30% of your grade, so be
diligent in writing your paper and getting help from your TA immediately if you have any problems.

Three Detailed Observation Notes

You will turn in observation notes from three observation sessions you complete during the data
collection process for you qualitative research project. The notes must be detailed, typed, and
demonstrate your ability to write high quality observation notes to collect substantive qualitative data.
The first set of observation notes is due November 7%. The second set is due November 21%. The third
set of observation notes is due December 5. Notes are due by 11:59 p.m. on their respective due dates.

One Transcribed Interview

You are required to conduct a minimum of one interview for your qualitative project. You will transcribe
one of your interviews that will be turned in on Blackboard. You will be graded on the quality of
guestions and clarity of your transcription by sticking to proper formatting for transcribing interviews.
The transcription is due December 1% at 11:59 p.m.

Weekly Lab Assignments

The lab assignments are designed for you to acquire the necessary skills, knowledge, and tools to
complete your research proposal and final research paper. Labs are also designed for you to acquire, at
the minimum, a working knowledge of the different types of non-experimental methods psychologists use
such as observations, interviews, and non-experimental quantitative studies. Lab assignments are due
Fridays at 11:59 p.m. unless otherwise noted.

Participation Points (Class & Lab)

Reading the assigned material and completing the assignments before class and lab are important to
understanding the lecture topics and to participating in the discussions. Participation will be assessed
through in-class exercises, activities, and discussion. Exercises may occasionally be assigned in class in
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order to help you to understand the course material. Some exercises will be worked on in class while
others may be worked on in class and at home. Lab participation will be graded based on the completion
of a specific assignment or demonstration that will take place each lab.

EXTRA CREDIT: Participate in Research Studies and Worksheets

Part of understanding the research process is being a participant in a study. You may participate in
research studies conducted in the psychology department to earn extra credit. All points will be applied to
your Blackboard CT Assignments. You can view and sign up for studies through the SONA system at
https://usc.sona-systems.com/. You may complete 10 points of credit on SONA. Half of your points
must be completed by participating in lab experiments and not survey research. For each study, you will
fill out a worksheet about the study. The worksheet will be posted on Blackboard after the third week of
class. Please note that your participation in research is voluntary and you have the right to NOT
participate in research studies. If you do not want to participate in studies, then you may complete the
alternative, which is writing two five page papers on two topics posted on Blackboard.

Grading Scheme
A =100 - 93.5%; A- =93.4-89.5%; B+ =89.4 - 86.5%; B =86.4 - 83.5%; B-=83.4 -79.5%; C+ =

79.4 -76.5%; C =76.4 - 73.5%; C- =73.4 - 69.5%; D+ = 69.4 - 66.5%; D = 66.4 - 63.5%; D- =63.4 -
59.5%; Below 59.5% = F

Instructor Student Communication and Blackboard

Blackboard (Bb) will be used to post announcements, send e-mails, and post all grades and course
materials, so it is the student’s responsibility to frequently visit the course on Blackboard (website:
http://blackboard.usc.edu). Bb transactions will follow the below guidelines.

1) Grades: All grades and points will be posted on Bb one to two weeks after the completion of
the exam, assignment, or activity. Grades will not be announced in class, via e-mail, or during
office hours.

2) Course Materials: The syllabus, lab assignments, and supplemental reading material can be
viewed and printed from Bb.

3) Announcements: Class announcements will be posted on Bb, as well as broadcasted in class.

4) Email: Any email communications from the instructor or TA will be sent via Bb or through the
USC’s email service. USC requires that all e-mail communication between the instructor and
students be sent via an official USC e-mail address. Any student communication delivered from
a non-USC e-mail address will be automatically discarded.

Tentative Schedule of Topics and Assignments

Topic Reading Deliverables
WEEK 1
Tuesday Overview of Course Syllabus N/A
08/26/2014
Thursday » Defining non- » Chapter 1 » None
08/28/2014 experimental (CRES)
research » Chapter 2
» Philosophical (CRES) pp.
Assumptions 15-22
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WEEK 2

Tuesday » Interpretive Chapter 2 In-class project
09/02/2014 Frameworks (CRES) pp.
22 -41
Thursday » Interpretive Chapter In-class project
09/04/2014 Frameworks 1(MHS) (cont.)
(cont.) Presentations
WEEK 3
Tuesday » Approaches to Chapter 4 None
09/09/2014 Qualitative (CRES)
Research
Thursday » Approaches to Chapter 4 In-class project
09/11/2014 Qualitative (CRES)
Research (cont.)
WEEK 4
Tuesday » Example Frank Discussion
09/16/2014 Qualitative Study (2006)
Thursday » Example Studies Chapter 5 Short
09/18/2014 (CRES) Presentations
WEEK 5
Tuesday » Designing a Chapter 3 In-class exercises
09/23/2014 Project (CRES) pp.
42 - 56
Chapter 2
(MHS)
Thursday » Ethical Issues in Chapter 3 In-class group
09/25/2014 Qualitative (CRES) pp. work and
Research 56 - 60 exercises
Chapter 3
(MHS)
WEEK 6
Tuesday » Creating a Chapter 3 In-class exercise
09/30/2014 Proposal (CRES) pp.
61 - 68
Thursday » Sampling Beitin In-class exercise
10/02/2014 » Gaining Access (2012)
» Using Recording

Devices
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WEEK 7

Tuesday Conducting Chapter 6; In-class exercise
10/07/2014 Observations Patton
(2002)
Thursday Conducting Chapter 6; In-class activity
10/09/2014 Observations Patton
(cont.) (2002)
WEEK 8
Tuesday Conducting Chapter 7; In-class activity
10/14/2014 Interviews Patton
(2002)
Thursday Conducting Chapter 7; In-class exercise
10/16/2014 Interviews (cont.) Patton and group
Focus Groups (2002) activity
Wang &
Yang (2012)
WEEK 9
Tuesday Creating & Chapter 4 In-class exercise
10/21/2014 Modifying Codes (MHS)
Thursday Preparing to Chapter 5 In-class exercise
10/23/2014 Analyze Data (MHS)
WEEK 10
Tuesday Writing Chapter 9 In-class activity
10/28/2014 Qualitative (CRES)
Research Chapter 12
(MHS)
Thursday Proofing and None Bring in a FULL
10/30/2014 Revising Paper DRAFT of
Proposal
WEEK 11
Tuesday Describing What Chapter 7 In-class exercise
11/04/2014 Happened (MHS)
Thursday Ordering Events Chapter 8 In-class exercise
11/06/2014 & Processes (MHS)
WEEK 12
Tuesday Multiple Field (2011) In-class exercise
11/11/2014 Regression
Thursday Multiple Rohde & Discussion
11/13/2014 Regression Thompson
(2007)
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WEEK 13

Tuesday Meta-Analysis » Rosenthal & In-class exercise
11/18/2014 DiMatteo
(2001) pp.
59 -71
Thursday Meta-Analysis » Hyde (2005) Discussion
11/20/2014
WEEK 14
Tuesday No Class > N/A N/A
11/25/2014
Thursday No Class! > N/A N/A
11/27/2014 Thanksgiving
Break!
WEEK 15
Tuesday Structural » No Reading In-class exercise
12/02/2014 Equation
Modeling
Thursday Structural » Unsworth & Discussion
12/04/2014 Equation Spillers
Modeling (2010)
WEEK 16
Thursday Consultation Hours: 2:00 p.m. to 4:00 p.m.
12/11/2014 Qualitative Research Paper Due TODAY at 11:59 p.m.
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Tentative Schedule of Labs

Topic Reading Lab Assignments:
Due Fridays at 11:59
p.m.
WEEK 1
NO LAB
WEEK 2
LAB #1 View Options » No Reading » Summary and
on JEP Website argument of
Fill out where you will
Application volunteer
Deadline is
9/4 at 11:59
p-m. to
complete
application
WEEK 3
Lab #2 Reading and » Frank (20006) » Complete
Analyzing Questions in
Qualitative BGRAQ for
Research Frank’s (2006)
Articles Article
WEEK 4
Lab #3 Find Two » Two Articles » Complete BGRAQ
Qualitative You Found for Articles
Articles
WEEK 5
Lab #4 Find Two » Two Articles » Draft of Argument
Quantitative or you Found with Citations
Qualitative Reference Section
Articles on
Your Topic
WEEK 6
Lab #5 Ethics » Brinkmann » PDF of ALL Ethics
Certification & Kvale Certification
Benefits vs. (2008) » Completed
Risks Questionnaire
» Begin Volunteer
Service
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WEEK 7

Lab #6 Work on » Chapter 6 Draft of Proposal:
Proposal and (CRES) Minimum 5 pages
Turn in Draft
WEEK 8
Lab #7 Observation » Chapter 6; Detailed
Protocols Patton (2002) Observation
Protocol
WEEK 9
Lab #8 Interview » Wang & Yang Detailed Interview
Protocols (2012) Protocol
WEEK 10
Lab #9 Data Analysis » Chapter 8 Research
Plans (CRES) Proposal Due
October 30t at
11:59 p.m.
WEEK 11
Lab #10 Exploring Your » Chapter 6 Detailed
Data (MHS) Observation
Notes
WEEK 12
Lab #11 Read & Analyze » Chapter 9 Analysis of
Multiple (MHS) Multiple
Regression > Rohde & Regression Article
Article Thompson Analyze
(2007) Qualitative Data
WEEK 13
Lab #12 Read & Analyze » Chapter 10 Analysis of Meta-
Meta-Analysis (MHS) Analysis Article
Article » Hyde (2005) Analyze
Qualitative Data
WEEK 14
Lab #13 Work on Final » Chapter 11 Interview
Research Paper (MHS) Transcription
Work on Work on Final
Interview Paper
Transcription
WEEK 15
Lab #14 Work on Final » Unsworth & Analysis of SEM

Research Paper
Read & Analyze

SEM Article

Spillers
(2012)

Article
Work on Final
Paper
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Statement on Academic Integrity

USC seeks to maintain an optimal learning environment. General principles of academic honesty include
the concept of respect for the intellectual property of others, the expectation that individual work will be
submitted unless otherwise allowed by an instructor, and the obligations both to protect one’s own
academic work from misuse by others as well as to avoid using another’s work as one’s own. All students
are expected to understand and abide by these principles. SCampus, the Student Guidebook,
(www.usc.edu/scampus or http://scampus.usc.edu) contains the University Student Conduct Code (see
University Governance, Section 11.00), while the recommended sanctions are located in Appendix A.

Statement on Plagiarism

Plagiarism, lazy writing, and cheating are violations of the Student Judicial Affairs & Community
Standards and may be dealt with by both the instructor and the university. Plagiarism is defined as, “the
act of presenting the ideas and writings of another as one’s own.” Lazy writing is defined as, “using
guotes or paragraphs with the proper citation, but are used in a manner that a paper is stitched together
and clearly has little or no original writing.” Cheating is defined as, “the act of obtaining or attempting to
obtain credit for academic work through the use of any dishonest, deceptive, or fraudulent means.” In
instances of academic dishonesty, the instructor will take appropriate action as outlined in the Academic
Integrity Review Process (SJACS 14.10). For more information on avoiding plagiarism or lazy writing,
see Chapter 1, Section 1.10 in the APA Publication Manual or visit http://www.usc.edu/student-
affairs/student- conduct/ug_plag.htm.

Statement for Students with Disabilities

Any student requesting academic accommodations based on a disability is required to register with
Disability Services and Programs (DSP) each semester. A letter of verification for approved
accommodations can be obtained from DSP. Please be sure the letter is delivered to me or to the TA as
early in the semester as possible. DSP is located in STU 301 and is open 8:30 a.m.—5:00 p.m., Monday
through Friday. Website and contact information for DSP:
http://sait.usc.edu/academicsupport/centerprograms/dsp/home_index.html; Phone: (213) 740-0776; TDD
Only: (213) 740-6948; Fax: (213) 740-8216; email: ability@usc.edu.

Course Notes

1) Missed Assignments: Missed assignments cannot be made up and will result in a grade of zero.
Students who experience medical emergencies that prevent them from attending class on days
when class exercises or assignments are scheduled will be required to provide original
documentation from their physicians within one week explaining their absence. USC athletes
should meet with me as soon as possible regarding their scheduled athletic events that may
conflict with course requirements.

2) Feedback: Your lab instructor will make every attempt to return exams and assignments in a
reasonable time by returning them no later than two weeks after the due date.

3) Appeal Process: If you find that an answer in an assignment or quiz was incorrect, but you
think it is correct, you can appeal the decision in writing. The written appeal must have
supporting documentation (e.g., reference to a class reading). The appeal cannot be based on
your opinion or personal experience, but rather based on the course materials. Appeals must be
delivered to the instructor no later than one week after the grade is posted. Appeals will not be
accepted via email and no late appeals will be accepted.

4) Cell Phone and Electronic Device Policy: Cell phones should be turned off during class. Do
NOT leave cell phones on vibrate and do NOT text message during class. Absolutely NO
computers may be used during lectures. You may use your computer to view an electronic
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5)

6)

version of an article during discussions. You must have a note from the Disabilities Services
and Programs that states it is necessary for you to use your computer to take notes. Finally, no
class or lab sessions may be video or audio recorded.

Course Participation: You are expected to be prepared for class by completing the required
readings or exercises BEFORE class, and should be prepared for discussion of the assignments
(and participation point questions).

University Escort Service: If you feel that you would like to be escorted to your vehicle, bus, or
campus residence after 5:00 p.m., do not hesitate to call (213) 740-4911.

Special Notes

1)

2)

3)

4)

5)

This course is more based on service learning and applying the information you learn in class
and lab. There are no exams, midterm, or final exam. You will, however, need to dedicate the
time that you would typically spend studying for tests to volunteering and conducting your
research. As in any course, work of a significantly high caliber in each of the components of
this course is considered to be an A (i.e., exceptional work). It is especially important that you
be on time for class, have completed your reading assignments prior to class-time, and that you
are prepared for discussion of these materials in class.

All assignments in this course are expected to be word-processed and graphs/tables should be
computer-generated.

All assignments should be completed using APA-style, including the use of a title page.
Assignments are due on predetermined due dates and should be submitted electronically
through Bb. Word processing and data management software are available in several computer
labs on campus. You should consult your APA Publication Manual for all writing assignments.
All students are expected to have access to the student computer network. It is your
responsibility to ensure that your access is up-to-date during the semester.

Tutors are available for this course through the Learning Resource Center (LRC). If you should
find that you are not doing as well in this course as you would like, please see me immediately.
I will help you: It is my job! You can also arrange short-term or long-term tutoring through the
LRC. The Writing Center is also available to tutor students who are having difficulty with
writing. For assistance, visit their website at http://college.usc.edu/writingcenter/ or call (213)
740-3691.

Emergency Preparedness/Course Continuity in a Crisis

In case of a declared emergency if travel to campus is not feasible, USC executive leadership will
announce an electronic way for instructors to teach students in their residence halls or homes using a
combination of Blackboard, teleconferencing, and other technologies.

Statement of Course Content as a Copyright

It is important to know that all material presented in class, labs, or discussion sent via email or posted on
Blackboard is “all rights reserved” by the course instructor. In addition, some of it is copyrighted and
distributed by a publishing corporation for in-class use only. You may not store, post, or distribute any
course materials—on paper or electronically--for use by any student not presently enrolled in this
course. Out of fairness to all current and future students, please do your part to protect our course content.
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Syllabus as a Contract

The purpose of this syllabus is to provide a contract between the instructor and the student. By enrolling
in this class, you agree that you have read, understand, and will adhere to the syllabus guidelines and
complete the assignments given in the class. | reserve the right to change the schedule of topics and
readings and I will give notice to you of such changes well in advance of those changes.

(@) IMPROVEMENT

(@) DISTANCE BETWEEN (@) EPOCHE:
OBJECT AND SUBJECT sustaining from judgement
(@) DISTRIBUTION
— (@ EXPLICIT ASSUMPTIONS

(@) PREDICTION

(@) SVALL SAMPLES

theory ©
testing

@ theory

development

TRANSPARENT @ PERSPECTIVES/
O ARGUMENTATION DIFFERENT
O INTERPRETATIONS

B QUANTITATIVE B QUALITATIVE
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